Document Change Record
This page records changes to this document. The document was originally released as version 001.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description of Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>002</td>
<td>6/2005</td>
<td>Added information to support firmware version 1.1 including these features:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• HID keyboard profile</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SF51 Firmware Upgrade Utility</td>
</tr>
<tr>
<td>003</td>
<td>8/2005</td>
<td>Removed references to the HID keyboard profile, which is currently not supported on the SF51.</td>
</tr>
<tr>
<td>004</td>
<td>1/2006</td>
<td>• Added information to support firmware version 1.2 including these features:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Additional trigger mode settings, level trigger mode enhancements, and support for the Trigger Timeout and Turn Off After Good commands.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Support for the EAN.UCC Composite, and TLC 39 bar code symbologies, the Code 128 FNC2 control character, the code mark Symbology ID setting, and the Matrix 2 of 5 ChinaPost start/stop code.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Data editing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added references to Keyport Lite, a keyboard wedge application supported on the SF51 for English QWERTY keyboards.</td>
</tr>
</tbody>
</table>
Contents

Before You Begin ................................................................. ix
Safety Icons ........................................................................... ix
Global Services and Support ............................................. ix
Warranty Information ........................................................ ix
Web Support ...................................................................... x
Telephone Support .......................................................... x
Who Should Read This Document? ......................... xi
Related Documents .......................................................... xi
Patent Information ............................................................ xii

1 Using the SF51 ................................................................. 1

Introducing the SF51 Cordless Scanner ............................... 2
What's New? ........................................................................ 3
How to Turn On the SF51 .................................................. 4
Using the Battery ................................................................. 4
  Charging the Battery ....................................................... 5
  Checking the Battery Status ............................................ 5
Understanding the Lights ................................................... 5
Understanding the Beeps .................................................... 7
Using Vibrate Alert ............................................................. 8
Scanning Bar Codes .......................................................... 9
Collecting Data With Your SF51 ....................................... 10

2 Configuring and Managing the SF51 .............. 13

How to Configure the SF51 Parameters ............................. 14
  Configuring With EasySet ............................................. 14
  Configuring From Your Intermec Computer .............. 15
  Restoring Default Settings ............................................ 16
Contents

Bluetooth Security .................................................. 43
Codabar .............................................................. 43
Codablock A ........................................................ 43
Codablock F ........................................................ 43
Code 11 .............................................................. 43
Code 39 .............................................................. 44
Code 93/93i ........................................................ 44
Code 128 / EAN 128 .............................................. 44
Configuration Modes and Utilities ...................... 45
Consecutive Same Read Data Validation ............. 45
Data Editing ........................................................ 46
Disable All Symbologies ...................................... 46
EAN.UCC Composite ........................................... 46
Error Beep ........................................................... 46
Good Read Beep Duration .................................... 46
Good Read Beep Number ..................................... 47
Good Read Beep Timing ....................................... 47
Good Read LED Duration ..................................... 47
Interleaved 2 of 5 ............................................... 47
Matrix 2 of 5 ....................................................... 47
Micro PDF417 .................................................... 47
MSI ................................................................. 48
PDF417 .............................................................. 48
Plessey .............................................................. 48
Postamble ............................................................ 48
Preamble ............................................................ 48
RSS 14 ............................................................... 49
RSS Expanded .................................................... 49
RSS Limited ....................................................... 49
Setup Beep .......................................................... 49
Stacked Code Crackle ........................................... 49
Standard 2 of 5 .................................................... 49
Symbology Identifier ........................................... 50
Telepen .............................................................. 50
Timeout Between Different Consecutive Codes ... 51
Timeout Between Identical Consecutive Codes ... 51
TLC 39 ............................................................... 51
Trigger Mode ...................................................... 52
Trigger Timeout .................................................. 53
Turn Off After Good Read ................................... 53
UPC/EAN ........................................................... 54
User Reset Factory Defaults ................................ 54
Vibrate Alert ....................................................... 54
Vibrate Alert Duration .......................................... 54
Contents

A Appendix ........................................................................... 55

  Specifications ..................................................................... 56

  Accessories for the SF51 .................................................. 57

I Index ..................................................................................... 59
Before You Begin

This section provides you with safety information, technical support information, and sources for additional product information.

Safety Icons

This section explains how to identify and understand warnings, cautions, and notes that are in this document.

A warning alerts you of an operating procedure, practice, condition, or statement that must be strictly observed to avoid death or serious injury to the persons working on the equipment.

A caution alerts you to an operating procedure, practice, condition, or statement that must be strictly observed to prevent equipment damage or destruction, or corruption or loss of data.

Note: Notes are statements that either provide extra information about a topic or contain special instructions for handling a particular condition or set of circumstances.

Global Services and Support

Warranty Information

To understand the warranty for your Intermec product, visit the Intermec web site at www.intermec.com and click Service & Support > Warranty.

Disclaimer of warranties: The sample code included in this document is presented for reference only. The code does not necessarily represent complete, tested programs. The code is provided “as is with all faults.” All warranties are expressly disclaimed, including the implied warranties of merchantability and fitness for a particular purpose.
Before You Begin

Web Support
Visit the Intermec web site at www.intermec.com to download our current documents (in PDF). To order printed versions of the Intermec manuals, contact your local Intermec representative or distributor.

Visit the Intermec technical knowledge base (Knowledge Central) at intermec.custhelp.com to review technical information or to request technical support for your Intermec product.

Telephone Support
These services are available from Intermec Technologies Corporation.

<table>
<thead>
<tr>
<th>Service</th>
<th>Description</th>
<th>In the U.S.A. and Canada call 1-800-755-5505 and choose this option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order Intermec</td>
<td>Place an order.</td>
<td>1 and then choose 2</td>
</tr>
<tr>
<td>products</td>
<td>Ask about an existing order.</td>
<td></td>
</tr>
<tr>
<td>Order Intermec</td>
<td>Order printer labels and ribbons.</td>
<td>1 and then choose 1</td>
</tr>
<tr>
<td>media</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Order spare parts</td>
<td>Order spare parts.</td>
<td>1 or 2 and then choose 4</td>
</tr>
<tr>
<td>Technical Support</td>
<td>Talk to technical support about your Intermec product.</td>
<td>2 and then choose 2</td>
</tr>
<tr>
<td>Service</td>
<td>Get a return authorization number for authorized service center repair.</td>
<td>2 and then choose 1</td>
</tr>
<tr>
<td>Service contracts</td>
<td>Request an on-site repair technician.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ask about an existing contract.</td>
<td>1 or 2 and then choose 3</td>
</tr>
<tr>
<td></td>
<td>Renew a contract.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inquire about repair billing or other service invoicing questions.</td>
<td></td>
</tr>
</tbody>
</table>
Before You Begin

Outside the U.S.A. and Canada, contact your local Intermec representative. To search for your local representative, from the Intermec web site, click Contact.

Who Should Read This Document?

The SF51 Cordless Scanner User's Guide provides you with information about the features of the SF51. This guide is written for the person who is responsible for installing, configuring, maintaining, and troubleshooting the SF51.

Before you configure the SF51, you should be familiar with your network and general networking terms, such as IP address. You should also have a working knowledge of Bluetooth communications.

Related Documents

This table contains a list of related Intermec documents and their part numbers.

<table>
<thead>
<tr>
<th>Document Title</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>SF51 Cordless Scanner Quick Start Guide</td>
<td>074473</td>
</tr>
<tr>
<td>USB Bluetooth Adapter Instructions</td>
<td>074479</td>
</tr>
</tbody>
</table>

The Intermec web site contains Intermec documents (in PDF) that you can download for free.

To download documents

2. Click Service & Support > Manuals.
3. In the Select a Product field, choose the product whose documentation you want to download.

To order printed versions of the Intermec manuals, contact your local Intermec representative or distributor.
Before You Begin

Patent Information

Product is covered by one or more of the following patents: 4,766,300; 5,548,108; 5,912,452; 4,882,476; 5,550,362; 5,923,022; 4,894,523; 5,550,364; 5,936,224; 4,953,113; 5,565,669; 5,949,056; 4,970,379; 5,572,007; 5,969,321; 4,988,852; 5,576,529; 5,969,326; 5,019,699; 5,594,230; 5,979,768; 5,021,642; 5,598,007; 5,987,192; 5,038,024; 5,608,578; 5,992,750; 5,081,343; 5,616,909; 6,003,775; 5,095,197; 5,619,027; 6,012,640; 5,144,119; 5,640,001; 6,016,960; 5,144,121; 5,659,431; 6,018,597; 5,182,441; 5,672,860; 6,024,289; 5,187,355; 5,684,290; 6,034,379; 5,187,356; 5,719,678; 6,036,093; 5,216,233; 5,729,003; 6,039,252; 5,216,550; 5,742,041; 6,064,763; 5,218,191; 5,761,219; 6,095,422; 5,233,172; 5,764,798; 6,097,839; 5,241,488; 5,777,308; 6,102,289; 5,243,602; 5,777,309; 6,102,295; 5,258,606; 5,777,310; 6,119,941; 5,288,985; 5,786,583; 6,128,414; 5,308,966; 5,798,509; 6,138,915; 5,342,210; 5,798,513; 6,149,061; 5,359,185; 5,804,805; 6,149,063; 5,389,770; 5,811,770; 6,152,370; 5,397,885; 5,811,777; 6,155,490; 5,414,251; 5,818,027; 6,158,661; 5,416,463; 5,821,523; 6,164,542; 5,442,167; 5,834,749; 6,164,545; 5,464,972; 5,837,987; 6,173,893; 5,468,947; 5,841,121; 6,195,053; 5,468,950; 5,842,070; 6,234,393; 5,477,044; 5,854,478; 6,234,395; 5,486,689; 5,862,267; 6,249,008; 5,500,516; 5,869,840; 6,328,214; 5,502,297; 5,873,070; 6,330,975; 5,504,367; 5,877,486; 6,345,765; 5,514,858; 5,878,395; 6,356,949; 5,534,684; 5,886,338; 6,367,699; 5,536,924; 5,895,906; 6,375,075; 5,539,191; 5,902,987; 6,375,076; 5,541,419; 5,902,988; 6,435,411.

There may be other U.S. and foreign patents pending.
Use this chapter to familiarize yourself with the SF51 Cordless Scanner. This chapter covers these topics:

- Introducing the SF51 Cordless Scanner
- What’s New?
- How to Turn On the SF51
- Using the Battery
- Understanding the Lights
- Understanding the Beeps
- Using Vibrate Alert
- Scanning Bar Codes
- Collecting Data With Your SF51
Chapter 1 — Using the SF51

Introducing the SF51 Cordless Scanner

The SF51 Cordless Scanner is a small, rugged handheld scanner. It is a lightweight, ergonomically designed scanner that uses a Bluetooth™ radio for RF communications.

The SF51 includes these features:

- **Scan button**
- **Magnetic connector**
- **Status light**
- **Intermec Ready-to-Work indicator**

* SF51 Cordless Scanner

---

This device contains permanent magnets that can generate magnetic fields of greater than 10 gauss. Caution should be used by anyone with a Pacemaker, Implantable Cardioverter Defibrillator (ICD), or Heart Failure Device. Check with your doctor for detailed information before using this device.

---

Caution
What’s New?

This revision of the user’s guide includes new information to support the firmware version 1.2 release:

- Keyport Lite, a keyboard wedge application, is supported for English QWERTY keyboards. To order Keyport Lite, contact your local Intermec representative. For more information about using Keyport Lite, see “Connecting as a Keyboard Wedge” on page 21.

- The Trigger Mode configuration command now supports three additional trigger modes: Pulse, Flashing, and Autostand. For more information, see “Trigger Modes” on page 52.

- The Level trigger mode now provides a feedback mechanism for indicating slow data transmission. For more information, see “Trigger Modes” on page 52.

- Two trigger activation commands have been added: Trigger Timeout and Turn Off After Good Read. For more information, see “Trigger Timeout” on page 53 and “Turn Off After Good Read” on page 53.

- You can use the Data Editing command to edit data scanned by the SF51 before it is transmitted to your host. For more information, see “Data Editing” on page 46.

- Two additional bar code symbologies are supported on the SF51: EAN.UCC Composite and TLC 39. For more information, see “EAN.UCC Composite” on page 46 and “TLC 39” on page 51.

- Code Mark has been added as a Symbology Identifier option. For more information, see “Symbology Identifier” on page 50.

- Support for the FNC2 control character has been added to Code 128. For more information, see “Code 128/EAN 128” on page 44.

- ChinaPost is available as part of the Matrix 2 of 5 symbology start/stop code. For more information, see “Matrix 2 of 5” on page 47.
How to Turn On the SF51

You use the Scan button to turn on the SF51.

To turn on the SF51

- Press the Scan button.

The first time you press the Scan button to turn on the SF51, it enters a discoverable state so that your host Bluetooth device can perform a device discovery and establish a Bluetooth connection.

If the status light on the SF51 turns red when you try to turn on the scanner, you need to charge the battery. For help, see “Charging the Battery” on page 5.

To turn off the SF51

- Scan this bar code:

Scanner Power Down

Using the Battery

The SF51 uses a lithium-ion battery as its main power source. You need to fully charge the battery before you can use the SF51.

The lithium-ion battery pack that is used in this device may present a fire or chemical burn hazard if it is mistreated. Do not disassemble it, heat it above 100°C (212°F) or incinerate it.
Charging the Battery

Make sure you fully charge the battery before you start using the SF51.

To charge the battery

- Place the SF51 in the 1-bay charger (P/N 074645) or the 4-bay charger (P/N 074646). A fully discharged battery charges to 100% capacity in approximately 3 hours.

  It may take longer than 3 hours to charge the battery if the temperature is near the minimum (0°C, 32°F) or maximum (45°C, 113°F) charging temperature.

  **Note:** When you place the SF51 in the 1-bay or 4-bay charger, you reset the SF51 scanner control firmware. For more information, see “Resetting the SF51” on page 32.

Checking the Battery Status

- Press the Scan button.

  If the status light on the SF51 turns red, the battery is low (less than 20% battery capacity remaining). You need to charge the battery now.

Understanding the Lights

The lights on the SF51 turn on to indicate the status of the battery, a successful decode of a bar code, or the status of the Bluetooth connection.
Chapter 1 — Using the SF51

SF51 Lights: The status light turns green or red to indicate the status of the battery and scanning. The blue Intermec Ready-to-Work™ indicator turns on to let you know that the SF51 is ready to send data to your host Bluetooth device.

Status Light Description

<table>
<thead>
<tr>
<th>Light State</th>
<th>What It Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blinks green one time</td>
<td>The SF51 successfully decoded a bar code and sent the data to the host.</td>
</tr>
<tr>
<td></td>
<td>The SF51 successfully scanned a configuration bar code.</td>
</tr>
<tr>
<td>Flashes red when you press the Scan button</td>
<td>The battery is low. You need to place the SF51 in the 1-bay or 4-bay charger.</td>
</tr>
<tr>
<td>Flashes red and stays on for 2 seconds</td>
<td>You scanned a bar code, but the data was not sent to the host.</td>
</tr>
<tr>
<td></td>
<td>You scanned a configuration bar code and the SF51 did not accept it.</td>
</tr>
</tbody>
</table>

Note: When the SF51 is in the 1-bay or 4-bay charger, the status light indicates the battery charging status. For more information, see the instructions that ship with the charger.
Chapter 1 — Using the SF51

Intermec Ready-to-Work Indicator Description

<table>
<thead>
<tr>
<th>Light State</th>
<th>What It Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>A Bluetooth connection to the host computer is not established.</td>
</tr>
<tr>
<td>Blinking</td>
<td>The SF51 is trying to establish a Bluetooth connection with the host computer, or the SF51 is moving out of range of the host computer.</td>
</tr>
<tr>
<td>On</td>
<td>A Bluetooth connection with the host computer has been established. The SF51 is ready to scan bar codes and send data to the host computer.</td>
</tr>
</tbody>
</table>

Understanding the Beeps

The SF51 uses beeps to give you audio feedback when it performs some functions. For example, you hear a beep each time you scan a valid bar code.

**SF51 Beeps Description**

<table>
<thead>
<tr>
<th>Beep Sequence</th>
<th>What It Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single beep</td>
<td>The SF51 successfully decoded a bar code or scanned a configuration bar code.</td>
</tr>
<tr>
<td>Series of beeps from low to high</td>
<td>The SF51 connected to a Bluetooth host.</td>
</tr>
<tr>
<td>Series of beeps from high to low</td>
<td>A Bluetooth connection has been lost.</td>
</tr>
<tr>
<td>Three beeps</td>
<td>Data was not successfully sent to the host. The SF51 is out of range of the host. A configuration bar code was not successfully scanned.</td>
</tr>
<tr>
<td>Continuous beeping for 1 minute</td>
<td>The host PC is paging the SF51. After you find the SF51, press the Scan button to stop the beeps. For more information about paging the SF51, see “Locating the SF51” on page 32.</td>
</tr>
</tbody>
</table>
Chapter 1 — Using the SF51

You can change the beep volume for your needs and environment. You can set the beep volume to Low (quiet), Medium (loud), and High (very loud - default).

**Note:** To turn off the beeper, you set the Beep Duration to 0. Turning off the beeper does not affect the beeps associated with Bluetooth Connect/Disconnect or Bluetooth Device Page.

You can also change the beeper duration and beeper frequency. For more information about the beeper commands, see Chapter 4, “Configuration Command Reference.”

**Using Vibrate Alert**

You can configure the SF51 to vibrate when a bar code is successfully decoded. This feature can be useful in these situations:

- You are in a noisy environment, such as a busy warehouse, where it can be difficult to hear the beep.
- You are working in a quiet environment, such as a library, where you do not want to make a lot of noise.

**To turn on vibrate alert**

- Scan this bar code:

  Turn On Vibrate Alert

  ![Barcode Image]

**To turn off vibrate alert**

- Scan this bar code:

  Turn Off Vibrate Alert

  ![Barcode Image]
Chapter 1 — Using the SF51

Scanning Bar Codes
The SF51 has a linear imager you can use to scan and enter bar code data. The linear imager can decode 1D and 2D stacked bar codes. When you unpack the SF51, these bar code symbologies are enabled:

- Code 39
- Code 128/EAN 128
- PDF417 (only available on the SF51 with PDF version)
- UPC/EAN

If you are using bar code labels that are encoded in a different symbology, you need to enable the symbology on the SF51. Use EasySet version 5.4 or later to enable and disable symbologies for your scanner. EasySet is available on the CD that ships with the SF51, or you can download it at no charge from the Intermec web site at www.intermec.com.

To scan a bar code label

1. Establish a Bluetooth connection between the SF51 and your host device. For more information about establishing a Bluetooth connection, see “Connecting the SF51 to a Host Device” on page 18.

2. Point the SF51 at the bar code label and hold the SF51 at a slight angle 15 to 25 cm (6 to 10 in) from the label.

3. Press the Scan button. The scanner beam turns on. Scan this test bar code:

   Code 39 Test Bar Code
   
   *123456*

   **Tip:** Depending on your screen resolution, you may be able to scan bar codes displayed on your computer screen.

4. If you are scanning a 1D bar code, direct the red scanner beam so that it falls across all bars in the bar code label.
Chapter 1 — Using the SF51

If you are scanning a 2D bar code, pass the beam over the bar code label in a steady sweeping motion. The scanner emits a crackle sound.

Scanning With the SF51: There are two different ways to comfortably hold the SF51.

When the SF51 successfully reads a bar code label, you hear a single beep and the status light briefly turns green. If Vibrate Alert is enabled, the SF51 briefly vibrates.

5 Release the Scan button.

Collecting Data With Your SF51

After you connect your SF51 to your host device, you are ready to start collecting data. The method you use depends on whether you are using:

- an Intermec computer.
- a host PC.
- the SF51 as a keyboard wedge.
Chapter 1 — Using the SF51

To collect data with your SF51

1 Establish a Bluetooth connection.
2 Start your data collection application.
3 (Host PC only) Configure your data collection application to receive data from the incoming or outgoing COM port.
4 Scan a bar code with your SF51. The data is entered into your application.

For more information, see “Connecting the SF51 to a Host Device” on page 18.
Chapter 1 — Using the SF51
2 Configuring and Managing the SF51

Use this chapter to understand how to configure the SF51 to communicate with your application. This chapter covers these topics:

• How to Configure the SF51 Parameters
• Configuring Bluetooth Communications
• Connecting the SF51 to a Host Device
• Upgrading Your SF51
Chapter 2 — Configuring and Managing the SF51

How to Configure the SF51 Parameters

You can configure many parameters on the SF51, such as the bar code symbologies it decodes or the volume of the beeper. These characteristics are controlled by configuration commands. The values you set for these configuration commands determine how the scanner operates.

You can configure the SF51:

- using EasySet version 5.4 or later either online or offline.
- remotely from your Intermec computer.

Configuring With EasySet

EasySet is an Intermec configuration application that provides you with two ways to configure the SF51:

- Online: Send configuration commands directly to the SF51.
- Offline: Send configuration commands to a bar code setup sheet. You can scan the bar codes onscreen with your SF51 or print the setup sheet and scan the bar codes. You do not need a Bluetooth connection to use this method.

To configure the SF51 online with EasySet

1 Establish a Bluetooth connection with your host PC. For help, see the *USB Bluetooth Adapter Instructions* (P/N 074479).

2 Start EasySet version 5.4 or later. The first time you start EasySet, the Select product dialog box appears.

   If the Select product dialog box does not appear, choose *Product > Select*.

3 Select the SF51.

4 Select the **Online Setup** check box, and click **OK**. The Online Setup dialog box appears.

5 Select the COM port that your SF51 is using for Bluetooth communications, and click **OK**.

   EasySet connects to your SF51 and retrieves the current configuration of the SF51.
Chapter 2 — Configuring and Managing the SF51

6 In the Commands window, choose configuration command settings for your SF51.

Your SF51 is updated with the new configuration command settings, and the settings are added to the bar code setup sheet.

Note: The SF51 does not beep when you send configuration commands online from EasySet.

To configure the SF51 offline with EasySet

1 Start EasySet version 5.4 or later. The first time you start EasySet, the Select product dialog box appears.

   If the Select product dialog box does not appear, choose Product > Select.

2 Select the SF51, and click OK.

3 In the Commands window, choose configuration command settings for your SF51 and add them to the bar code setup sheet.

4 Scan the bar codes onscreen with your SF51, or print the setup sheet and scan the commands. When you scan bar code configuration commands, the SF51 emits a series of beeps unless the volume is turned off.

   • One beep means you scanned a valid configuration command.
   • Three beeps means you scanned an invalid configuration command.

For more information about EasySet, see the EasySet software.
For descriptions of the configuration commands, see Chapter 4, “Configuration Command Reference.”

Configuring From Your Intermec Computer

You can configure many settings for the SF51 from your Intermec computer. For descriptions of the configuration commands, see Chapter 4, “Configuration Command Reference.”
Chapter 2 — Configuring and Managing the SF51

To configure the SF51 from your Intermec computer

1. Establish a Bluetooth connection with your Intermec computer. For help, see “Connecting to an Intermec Computer” on page 19.

2. On your Intermec computer, start the Intermec Settings application.

3. Select Data Collection > SF51 Scanner Bluetooth Address, where Bluetooth Address is the Bluetooth address of your SF51.

4. Configure commands from the SF51 Scanner menu for your SF51.

5. Select File > Save Settings. The SF51 is updated with the new configuration command settings.


Restoring Default Settings

You can restore the SF51 to its default settings by scanning the Administrator Reset Factory Defaults command. For a list of the default settings, see “Configuration Commands by Function” on page 37.

Note: Using the Administrator Reset Factory Defaults command resets all parameters. As a result, you will lose Bluetooth communications.

To restore default settings

• Scan this bar code: Administrator Reset Factory Defaults
Configuring Bluetooth Communications

The SF51 can communicate with a host device through the Serial Port Profile (SPP) Bluetooth communications profile.

SPP allows the SF51 to use the Bluetooth link as a serial port to communicate with the host device. You can send information from the SF51 to your serial application without having to modify your application.

You can initiate a Bluetooth connection from either your SF51 or host device:

- If you initiate the connection from your SF51, you can only connect one SF51 to your host device. When you reset the SF51 by placing it in a charger, the SF51 automatically reestablishes the Bluetooth connection.

- If you initiate the connection from a host device, you can connect more than one SF51 to the same host device. When you reset the SF51 by placing it in a charger, you need to reestablish the Bluetooth connection from your host device.

Configuring Security

The SF51 provides Bluetooth wireless security for transmitting data. By default, security is active on your SF51. For maximum security, you need to configure a Bluetooth PIN (personal identification number).

This section assumes that you have already installed EasySet version 5.4 or later.

To configure a Bluetooth PIN for your SF51

1. Start EasySet version 5.4 or later.
2. Select the SF51, and click OK.
3. In the Commands window, select Data transmission settings > Bluetooth parameters > security.
4. Select active.
5. Select compose PIN and create a Bluetooth PIN that is up to 16 characters in length. The default Bluetooth PIN is 0000.
Chapter 2 — Configuring and Managing the SF51

6 Scan both commands onscreen with your SF51, or print the bar code setup sheet and scan both commands.

Note: For security reasons, you can only change the Bluetooth PIN by scanning a bar code.

Configuring the Discoverable State of the SF51

By default, the SF51 is always discoverable. For enhanced security, you should configure your SF51 for limited discoverability, which allows the SF51 to be discoverable by Bluetooth management applications for only 30 seconds. For more information, see “Bluetooth Discoverable” on page 42.

To configure your SF51 for limited discoverability

- Scan this bar code:

  Bluetooth parameters - discoverable - limited

![Barcode Image]

The SF51 is discoverable for 30 seconds.

Connecting the SF51 to a Host Device

You can use Bluetooth radio communications to connect the SF51 to:

- an Intermec computer with a Bluetooth radio, such as the 700 Color Series (with Windows Mobile 2003 or later), CK30, and CK60.
- a PC with a USB Bluetooth adapter (P/N 074892).
- other devices with a Bluetooth radio that support a Serial Port Profile (SPP). For help, see the documentation for your device.

Before connecting the SF51 to a host device, note the Bluetooth address for the:

- host Bluetooth device.
Chapter 2 — Configuring and Managing the SF51

- SF51.

**SF51 Bluetooth Address:** The SF51 Bluetooth address is located in the upper right corner of the label on the back of the SF51.

**Connecting to an Intermec Computer**

**Note:** When you connect to an Intermec computer, all SF51 settings that are common to the Intermec computer’s internal scanner settings are changed to the default settings of the internal scanner.

1. Install EasySet version 5.4 or later on a host PC. EasySet is available on the CD that shipped with the SF51 or from the Intermec web site at www.intermec.com.
2. Start EasySet. Make sure that SF51 is selected as your product.
3. From the EasySet commands window, select **Data transmission settings > Bluetooth parameters > connect/disconnect**.
4. Double-click **compose BT address**.
5. Enter the Bluetooth address of your Intermec computer and click **OK**. The bar code appears on the setup sheet.
6. Scan the bar code onscreen with the SF51, or print the bar code setup sheet and scan the bar code. The SF51 beeps once, the green status light flashes once, and the blue Intermec Ready-to-Work indicator starts blinking.
Chapter 2 — Configuring and Managing the SF51

When the SF51 connects to your Intermec computer, the SF51 emits a series of beeps from low to high, and the blue Intermec Ready-to-Work indicator turns on and stays on. The SF51 is ready to scan data.

Note: To connect more than one SF51 to your Intermec computer, use the Bluetooth Device Utility or the Bluetooth control panel on the Intermec computer. For help, see the documentation for your Intermec computer.

Connecting to a Host PC With the USB Bluetooth Adapter

1. Install EasySet version 5.4 or later. EasySet is available on the CD that shipped with the SF51 or from the Intermec web site at www.intermec.com.

2. Install the USB Bluetooth adapter (P/N 074892) and software on your host PC.

3. Connect and pair your SF51 with your host PC.

For help, see the USB Bluetooth Adapter Instructions (P/N 074479) that ship with the adapter.

To disconnect from a host PC

- Scan this bar code:

  Bluetooth Device Disconnect

The SF51 disconnects from your host PC, emits a series of beeps from high to low, and the blue Intermec Ready-to-Work indicator turns off.

Tip: Depending on your screen resolution, you may be able to scan bar codes displayed on your computer screen.
Chapter 2 — Configuring and Managing the SF51

Connecting as a Keyboard Wedge

Keyport Lite is a keyboard wedge application that lets your host PC receive data from the SF51 as it would from a keyboard. This application supports the SF51 for English QWERTY keyboards. To order Keyport Lite, contact your local Intermec representative.

To connect as a keyboard wedge

1. Connect your SF51 to your host PC. For help, see “Connecting to a Host PC With the USB Bluetooth Adapter” on page 20.

2. Install Keyport Lite on your PC.

3. Start Keyport Lite. From the **Window** menu, select **Change Registration**. The Registration Form appears.

4. Fill in the information on the Registration Form, and click **OK**.
Chapter 2 — Configuring and Managing the SF51

5 From the **Window** menu, select **Options**. The Options window appears.

![Options window](image)

6 In the **Port** field, select the COM port being used for Bluetooth communications, and click **OK**.

**Note:** You can use either the incoming or outgoing COM port.

7 Click the **Start** button. Your SF51 is connected to your host PC as a keyboard wedge.

For more information about Keyport Lite, see the documentation that ships with the product.

**Upgrading Your SF51**

When you upgrade your SF51, you update the SF51 processor firmware. The current settings are erased and replaced with the default settings for the SF51. You need to reestablish Bluetooth communications between your SF51 and other Bluetooth devices and applications in your data collection system.

To upgrade the SF51, you need these items:

- SF51 firmware upgrade package:
  - SF51Upgrade.exe (SF51 Firmware Upgrade Utility)
  - SF51_01_02.ldr (firmware upgrade file)
  - readme.txt (upgrade instructions)
- USB Bluetooth adapter (P/N 074892)
- PC running Microsoft Windows 2000/XP with SP1 or SP2
Before upgrading the SF51, you should fully charge the SF51 battery. For help, see “Charging the Battery” on page 5.

**To upgrade the SF51**

   - Go to Service & Support > Downloads.
   - From the Select A Product drop-down list, choose Bar Code Scanners: SF51 Cordless Scanner.
   - Click the link to download the upgrade package, and save it to your PC.

2. Remove the SF51 from the charger.

3. If necessary, install the USB Bluetooth adapter (P/N 074892) and create a Bluetooth connection between your SF51 and your PC. For help, see the USB Bluetooth Adapter Instructions (P/N 074479) that ship with the adapter.

   **Note:** Make sure that all applications on your PC are closed.

4. Start the SF51 Firmware Upgrade Utility.

5. Click **Browse** to browse to the location of the firmware (.ldr) file.

6. Select the firmware file and click **Open**.

7. From the **COM Port** drop-down list box, select the COM port that the SF51 is using for Bluetooth communications.

8. Click **Next**. The upgrade utility gets the Bluetooth address and current version of firmware on your SF51.

9. Click **Upgrade**. The status bar appears and the upgrade utility upgrades your SF51 with the latest firmware.

   **Note:** Do not place the SF51 in the 1-bay or 4-bay charger during the firmware upgrade, because the SF51 may lock up.

The upgrade utility notifies you when the upgrade is complete.
Chapter 2 — Configuring and Managing the SF51

Troubleshooting the Firmware Upgrade

If the SF51 locks up during the upgrade procedure and does not respond when you press the Scan button or place it in a charger, you may still be able to connect to it from your PC and upgrade the firmware.

To troubleshoot a locked up SF51

1. Make sure that the SF51 is not seated in the 1-bay or 4-bay charger.
2. From your PC, use the Bluetooth application to search for Bluetooth devices.
3. If your SF51 appears in the list, connect to it from the Bluetooth application.
   If your SF51 does not appear in the list, contact Intermec Support Services at 1-800-755-5505.
4. When the Bluetooth PIN Code Request box appears, enter the following case-sensitive PIN in the Bluetooth PIN Code field, and click OK:
   
   zxcvasdfqwer

   The Bluetooth application connects to the boot loader code on your SF51. "Intermec SF51 Boot Server" may appear in the Device Name list instead of the name of your SF51 scanner.
5. Use your Bluetooth application to connect to the Intermec SF51 Boot Server.
6. Start the SF51 Firmware Upgrade Utility.
7. Click Browse to browse to the location of the firmware (.ldr) file. Select the firmware file and click Open.
8. From the COM Port drop-down list box, select the COM port that the Intermec SF51 Boot Server is using for Bluetooth communications.
9. Click Next. The Bluetooth address of your SF51 appears, the status bar appears, and the upgrade utility upgrades your SF51 with the latest firmware.
Note: The next time you connect to your PC, your SF51 device name may be “Intermec SF51 Boot Server.” When the Bluetooth PIN Code Request box appears, enter the default PIN, which is 0000. After you connect, the name and Bluetooth address of your SF51 should appear in your Bluetooth application.
Chapter 2 — Configuring and Managing the SF51
Use this chapter to solve problems you may have while using the SF51. This chapter contains these topics:

- Troubleshooting the SF51
- Locating the SF51
- Resetting the SF51
- Cleaning the SF51
Chapter 3 — Troubleshooting and Maintaining the SF51

Troubleshooting the SF51

Use this chapter to troubleshoot some common problems you may experience with your SF51. If you cannot find the answer to your problem in the “Problems and Solutions” section on page 29, you may need to call Product Support.

Calling Product Support

To talk to an Intermec Product Support representative, call:

1-800-755-5505

Before you call Intermec Product Support, make sure you have the following information ready:

- Product version
- Sub-system versions
- Bluetooth address of your SF51

To get the product version, sub-system versions, or Bluetooth address

1 If necessary, install the USB Bluetooth adapter (P/N 074892) and create a Bluetooth connection between your SF51 and your PC. For help, see the USB Bluetooth Adapter Instructions (P/N 074479) that ship with the adapter.

2 Run an application that can accept bar code information from the SF51, such as HyperTerminal.

3 Scan these bar codes:

Get Product Version

Get Sub-System Versions
### Chapter 3 — Troubleshooting and Maintaining the SF51

Get SF51 Bluetooth Device Address

Tip: Depending on your screen resolution, you may be able to scan bar codes displayed on your computer screen.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your SF51 has been misplaced, and you cannot find it.</td>
<td>If your SF51 is within Bluetooth communication range of your host PC, you can send the Bluetooth Device Page command from EasySet to locate your SF51. For help, see “Locating the SF51” on page 32.</td>
</tr>
<tr>
<td>You place the SF51 in a charger and lose Bluetooth communications.</td>
<td>When you place the SF51 in a 1-bay or 4-bay charger, you reset the SF51, and the scanner control firmware restarts. If you have a Bluetooth connection, the SF51 disconnects from the host device while the firmware resets. For more information, see “Resetting the SF51” on page 32.</td>
</tr>
<tr>
<td>You cannot establish a Bluetooth connection (the blue Intermec Ready-to-Work indicator is not on).</td>
<td>Scan the following bar code to reset the scanner to its default configuration and try establishing a connection again. Administrator Reset Factory Defaults</td>
</tr>
</tbody>
</table>

Note: Using the Administrator Reset Factory Defaults command resets all settings. As a result, you will lose Bluetooth communications.
### Problems and Possible Solution (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you press the Scan button, the Status light flashes red.</td>
<td>The battery is low. Charge the battery immediately and try scanning again.</td>
</tr>
<tr>
<td>When you press the Scan button, the red scanner beam does not turn on.</td>
<td>The battery is low. Charge the battery immediately and try scanning again.</td>
</tr>
<tr>
<td>You are trying to establish a Bluetooth connection from a host device to</td>
<td>The SF51 may not be in a discoverable state. For help, see “Bluetooth Discoverable” on page 42.</td>
</tr>
<tr>
<td>your SF51, but the host device cannot find your SF51.</td>
<td>The SF51 may be connected and paired to another Bluetooth device. Scan the following bar code to reset the SF51 to its default settings and disconnect Bluetooth communications. Try establishing a connection again.</td>
</tr>
<tr>
<td>Administrator Reset Factory Defaults</td>
<td></td>
</tr>
<tr>
<td>Note: Using the Administrator Reset Factory Defaults command resets all</td>
<td></td>
</tr>
<tr>
<td>settings. As a result, you will lose Bluetooth communications.</td>
<td></td>
</tr>
<tr>
<td>You established a Bluetooth connection with an Intermec computer, and</td>
<td>When you connect to an Intermec computer, all SF51 settings that are common to the Intermec computer’s internal scanner settings are changed to the default settings of the internal scanner. Scan configuration bar codes, or use Intermec Settings on your Intermec computer to change your SF51 settings.</td>
</tr>
<tr>
<td>the settings on your SF51 were restored to their default values.</td>
<td></td>
</tr>
</tbody>
</table>
### Problems and Possible Solution (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You changed the Bluetooth PIN from its default value of 0000, but you forgot your new PIN number.</td>
<td>Scan this bar code to reset the scanner to its default configuration and default Bluetooth PIN of 0000. Administrator Reset Factory Defaults</td>
</tr>
<tr>
<td>You press the <strong>Scan</strong> button to scan a data bar code, the SF51 does not beep, and the scanner beam starts blinking.</td>
<td>The data may still be in the process of being sent to the host. Data transmission may be slow if there is interference with Bluetooth communications, or if the SF51 is too far from the host device. If you are using Level Trigger Mode, the scanner beam blinks while the SF51 is waiting. For more information, see “Trigger Mode” on page 52.</td>
</tr>
<tr>
<td>You scan a bar code, the Status light flashes red for two seconds, and the scanner beeps three times.</td>
<td>The SF51 may not be connected to a host. Make sure the blue Intermec Ready-to-Work indicator is on and the SF51 is connected to your host device. For help, see “Connecting the SF51 to a Host Device” on page 18.</td>
</tr>
</tbody>
</table>
| You are using the SF51 in keyboard wedge mode, and when you try to scan a bar code, and nothing happens. | Try these possible solutions:  
  - Make sure that your data collection application is open and running.  
  - Make sure that you pressed the Keyport Lite **Start** button. For help, see “Connecting as a Keyboard Wedge” on page 21. |
Chapter 3 — Troubleshooting and Maintaining the SF51

Locating the SF51

If your SF51 is within Bluetooth communication range of your host PC, you can send the Bluetooth Device Page command from EasySet to locate the SF51.

Note: If the SF51 is turned off, your host PC cannot connect to it and send the Bluetooth Device Page command.

To page the SF51

1. Start EasySet version 5.4 or later. Make sure that SF51 is selected as your product.
2. Select Communication > Connect.
3. Select the appropriate COM port, and click OK.
4. Select the Send to product check box below the commands window.
5. In the EasySet Commands window, select Configuration modes and utilities > Bluetooth device page.

The SF51 beeps continuously for 1 minute or until you find the SF51 and press the Scan button.

Resetting the SF51

If the SF51 appears to be locked up, you can reset it. When you reset the SF51, the scanner control firmware is restarted.

To reset the SF51

• Place the SF51 in the 1-bay or 4-bay charger.

If you have a Bluetooth connection, the SF51 disconnects from the host device.

When you reset the SF51:

• The SF51 tries to reestablish a Bluetooth connection with the host device if the SF51 initiated the Bluetooth connection.
• The SF51 turns on and enters a discoverable state if the host device initiated the Bluetooth connection. You need to reestablish the Bluetooth connection from the host device.
Cleaning the SF51

To keep the SF51 in good working order, you may need to clean the scanner window. Clean the scanner window as often as needed for the environment in which you are using the SF51. To clean the scanner window, you can use soapy water, a solution of ammonia and water, or isopropyl alcohol.

Opening the SF51 will void the warranty and may cause damage to the internal components.

To clean the scanner window

1. Dip a clean towel or rag in soapy water, ammonia and water solution, or isopropyl alcohol and wring out the excess. Wipe the scanner window. Do not allow any abrasive material to touch the window.
2. Wipe dry with a lint-free cloth.
Chapter 3 — Troubleshooting and Maintaining the SF51
Use this chapter to learn about the commands supported on the SF51. This chapter contains these topics:

- Using Configuration Commands
- Configuration Commands By Function
- SF51 Configuration Commands
Using Configuration Commands

A configuration command changes the way the SF51 operates. For example, you can change the Beep Volume and make the SF51 beeper very quiet for a quiet environment.

You can configure the SF51:

• using EasySet online. Send commands to your SF51 from your PC using EasySet. For help, see the procedure “To configure the SF51 online with EasySet” on page 14.

• using EasySet offline. Send commands to a bar code setup sheet. Then, scan the bar codes onscreen with your SF51, or print the setup sheet and scan the bar codes. You do not need a Bluetooth connection to use this method. For help, see the procedure “To configure the SF51 offline with EasySet” on page 15.

• from your Intermec computer. Send commands to your SF51 from your Intermec computer using Intermec Settings. For help, see the procedure “To configure the SF51 from your Intermec computer” on page 16.

For a list of all the commands and their default values as they are organized in EasySet, see the next section, “Configuration Commands By Function.”

For descriptions of each command organized alphabetically, see “SF51 Configuration Commands” on page 40.
## Configuration Commands By Function

The configuration commands are grouped by function and reflect the organization of the Commands window in EasySet.

### Reset All Parameters

<table>
<thead>
<tr>
<th>Command</th>
<th>Default Value</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator reset factory defaults</td>
<td>N/A</td>
<td>40</td>
</tr>
<tr>
<td>User reset factory defaults</td>
<td>N/A</td>
<td>54</td>
</tr>
</tbody>
</table>

### Data Transmission Settings

<table>
<thead>
<tr>
<th>Bluetooth Command</th>
<th>Default Value</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bluetooth security</td>
<td>Active</td>
<td>43</td>
</tr>
<tr>
<td>Bluetooth PIN</td>
<td>0000</td>
<td>42</td>
</tr>
<tr>
<td>Bluetooth discoverable</td>
<td>Fully discoverable</td>
<td>42</td>
</tr>
<tr>
<td>Bluetooth profile</td>
<td>Serial port profile (SPP)</td>
<td>42</td>
</tr>
<tr>
<td>Bluetooth device name</td>
<td>SF51 Scanner</td>
<td>41</td>
</tr>
<tr>
<td></td>
<td>&lt;Bluetooth Address&gt;</td>
<td></td>
</tr>
<tr>
<td>Bluetooth connect/disconnect</td>
<td>Disconnect</td>
<td>41</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data Transmission Command</th>
<th>Default Value</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data editing</td>
<td>N/A</td>
<td>46</td>
</tr>
<tr>
<td>Postamble</td>
<td>&lt;CR&gt;&lt;LF&gt;</td>
<td>48</td>
</tr>
<tr>
<td>Preamble</td>
<td>None</td>
<td>48</td>
</tr>
<tr>
<td>Symbology identifier</td>
<td>Not transmitted</td>
<td>50</td>
</tr>
</tbody>
</table>
## Chapter 4 — Configuration Command Reference

### Symbology Settings

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Default Value</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable all symbologies</td>
<td>N/A</td>
<td>46</td>
</tr>
<tr>
<td>Codabar</td>
<td>Not active</td>
<td>43</td>
</tr>
<tr>
<td>Codablock</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Codablock A</td>
<td>Not active</td>
<td>43</td>
</tr>
<tr>
<td>Codablock F</td>
<td>Not active</td>
<td>43</td>
</tr>
<tr>
<td>Code 11</td>
<td>Not active</td>
<td>43</td>
</tr>
<tr>
<td>Code 39</td>
<td>Active</td>
<td>44</td>
</tr>
<tr>
<td>Code 93/93i</td>
<td>Not active</td>
<td>44</td>
</tr>
<tr>
<td>Code 128/EAN 128</td>
<td>Active</td>
<td>44</td>
</tr>
<tr>
<td>ISBT 128</td>
<td>Active</td>
<td>45</td>
</tr>
<tr>
<td>GTIN processing</td>
<td>Not active</td>
<td>45</td>
</tr>
<tr>
<td>EAN.UCC Composite</td>
<td>Not active</td>
<td>46</td>
</tr>
<tr>
<td>Interleaved 2 of 5</td>
<td>Not active</td>
<td>47</td>
</tr>
<tr>
<td>Matrix 2 of 5</td>
<td>Not active</td>
<td>47</td>
</tr>
<tr>
<td>Micro PDF417</td>
<td>Not active</td>
<td>47</td>
</tr>
<tr>
<td>MSI</td>
<td>Not active</td>
<td>48</td>
</tr>
<tr>
<td>PDF417</td>
<td>Active</td>
<td>48</td>
</tr>
<tr>
<td>Plessey</td>
<td>Not active</td>
<td>48</td>
</tr>
<tr>
<td>RSS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RSS 14</td>
<td>Not active</td>
<td>49</td>
</tr>
<tr>
<td>RSS Expanded</td>
<td>Not active</td>
<td>49</td>
</tr>
<tr>
<td>RSS Limited</td>
<td>Not active</td>
<td>49</td>
</tr>
<tr>
<td>Standard 2 of 5</td>
<td>Not active</td>
<td>49</td>
</tr>
<tr>
<td>Telepen</td>
<td>Not active</td>
<td>50</td>
</tr>
<tr>
<td>TLC 39</td>
<td>Not active</td>
<td></td>
</tr>
<tr>
<td>UPC/EAN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ISBN</td>
<td>Not active</td>
<td>54</td>
</tr>
<tr>
<td>GTIN processing</td>
<td>Not active</td>
<td>54</td>
</tr>
</tbody>
</table>

**Note:** Stacked 2D bar code symbologies are only available on the PDF version of the SF51. For more information about setting symbology options, see the EasySet software.
Operating Settings

<table>
<thead>
<tr>
<th>Trigger Activation Command</th>
<th>Default Value</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger mode</td>
<td>Level</td>
<td>52</td>
</tr>
<tr>
<td>Trigger timeout</td>
<td>2 sec</td>
<td>53</td>
</tr>
<tr>
<td>Turn off after good read</td>
<td>Active</td>
<td>53</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data Decoding Security Command</th>
<th>Default Value</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consecutive same read data validation</td>
<td>Auto read count before transmission</td>
<td>45</td>
</tr>
<tr>
<td>Timeout between identical consecutive codes</td>
<td>300 ms</td>
<td>51</td>
</tr>
<tr>
<td>Timeout between different consecutive codes</td>
<td>None</td>
<td>51</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Beeps/Green Indicator LED Command</th>
<th>Default Value</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beep volume</td>
<td>High</td>
<td>41</td>
</tr>
<tr>
<td>Note (Beep frequency)</td>
<td>2610 Hz</td>
<td>40</td>
</tr>
<tr>
<td>Good read beeps</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>1</td>
<td>47</td>
</tr>
<tr>
<td>Duration</td>
<td>80 ms</td>
<td>46</td>
</tr>
<tr>
<td>Timing</td>
<td>After transmission</td>
<td>47</td>
</tr>
<tr>
<td>Good read LED duration</td>
<td>2000 ms</td>
<td>47</td>
</tr>
<tr>
<td>Error beep</td>
<td>On</td>
<td>46</td>
</tr>
<tr>
<td>Setup beep</td>
<td>On</td>
<td>49</td>
</tr>
<tr>
<td>2D symbologies</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stacked code crackle</td>
<td>On</td>
<td>49</td>
</tr>
<tr>
<td>Vibrate alert</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vibrate alert</td>
<td>Off</td>
<td>54</td>
</tr>
<tr>
<td>Duration</td>
<td>300 ms</td>
<td>54</td>
</tr>
</tbody>
</table>
Chapter 4 — Configuration Command Reference

Configuration Modes and Utilities

<table>
<thead>
<tr>
<th>Command</th>
<th>Default Value</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration modes and utilities</td>
<td>Configuration Enabled</td>
<td>45</td>
</tr>
<tr>
<td>Bluetooth device page</td>
<td>N/A</td>
<td>41</td>
</tr>
</tbody>
</table>

SF51 Configuration Commands

This section lists the configuration commands in alphabetical order and provides a description of each command. To configure your SF51 using these commands, see the EasySet software.

Administrator Reset Factory Defaults

Causes the SF51 to perform a restart and restores all configuration commands to their default settings. When you restore all configuration commands to their default settings, you need to reestablish Bluetooth communications.

Beep Duration

Sets the length of the beeps. You can set Beep Duration to a value from 0 to 2550 ms. When Beep Duration is set to 0 ms, the beeper is off. Turning off the beeper does not affect the beeps associated with Bluetooth Connect/Disconnect or Bluetooth Device Page.

Use Beep Duration in combination with Beep Frequency and Beep Volume to define beeps according to operator preference and work environment.

Beep Frequency

Sets the frequency, or pitch, of the beeps. You can set Beep Frequency to a value from 1000 to 5110 Hz.

Use Beep Frequency in combination with Beep Volume and Good Read Beep Duration to define beeps according to operator preference and work environment.
Chapter 4 — Configuration Command Reference

**Beep Volume**
Adjusts the volume of the beeps. You can set Beep Volume to Low, Medium, or High.

*Note:* To turn off the beeper, you set the Beep Duration to 0. Turning off the beeper does not affect the beeps associated with Bluetooth Connect/Disconnect or Bluetooth Device Page.

Use Beep Volume in combination with Beep Frequency and Good Read Beep Duration to define beeps according to operator preference and work environment.

**Bluetooth Connect/Disconnect**
Connects or disconnects Bluetooth communications between the SF51 and host computer if you are using Serial Port Profile (SPP).

To connect to a host computer, enter the Bluetooth address of the computer and scan the bar code with the SF51. To disconnect, scan the disconnect bar code.

**Bluetooth Device Name**
Sets the name of the scanner. If the scanner is in a discoverable state, its Bluetooth device name is available to host computers during device discovery.

**Bluetooth Device Page**
If your SF51 is within Bluetooth communication range of your host PC, you can send this command from EasySet to locate the SF51. For help, see “Locating the SF51” on page 32.
Chapter 4 — Configuration Command Reference

Bluetooth Discoverable

Determines the discoverable state of the SF51. When the SF51 is discoverable, it is visible to other Bluetooth devices in communication range.

Bluetooth Discoverable States

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fully</td>
<td>The SF51 is discoverable to Bluetooth management applications.</td>
</tr>
<tr>
<td>Limited</td>
<td>The SF51 is discoverable to Bluetooth management applications for 30 seconds.</td>
</tr>
<tr>
<td>Not</td>
<td>The SF51 is not discoverable to Bluetooth management applications.</td>
</tr>
</tbody>
</table>

Note: The SF51 is not discoverable when it is connected to a host device.

Bluetooth PIN

When Bluetooth security is enabled, the Bluetooth PIN is used to authenticate the Bluetooth link and encrypt the data. Depending on the Bluetooth software on your host device, you should only need to enter the Bluetooth PIN the first time you connect and pair the SF51.

For help configuring a Bluetooth PIN, see “Configuring Security” on page 17.

Bluetooth Profile

Configures the SF51 to connect to a host device through the Serial Port Profile (SPP) Bluetooth communications profile. SPP allows the SF51 to use the Bluetooth link as a serial port to communicate with the host device.

For more information, see “Configuring Bluetooth Communications” on page 17.
Bluetooth Security
Enables or disables Bluetooth security. When Bluetooth security is enabled, you need to enter the SF51 Bluetooth PIN before you can use the scanner. For more information, see “Configuring Security” on page 17.

Codabar
Enables or disables decoding of Codabar symbology. Codabar is a self-checking, discrete symbology. The American Blood Commission (ABC) Codabar requires that you retain and transmit the start/stop code digits when processing a Codabar symbol. As a result, configuration CD10 is an illegal configuration.

Codablock A
Enables or disables decoding of Codablock A symbology. Codablock A is a 2D bar code that is an extension of Code 39. If Code 39 is enabled with check digit, you cannot enable Codablock A. For best results, disable Code 39 before you enable Codablock A. If Code 39 is enabled with check digit, Codablock A will not be decoded properly.

Codablock F
Enables or disables decoding of Codablock F symbology. Codablock F is a 2D bar code that is an extension of Code 128. If Code 128 is enabled with check digit, you cannot enable Codablock F. For best results, disable Code 128 before you enable Codablock F.

Code 11
Enables or disables decoding of Code 11 symbology. Code 11 is a very high-density, discrete numeric bar code. It is most extensively used in labeling telecommunications components and equipment.
Chapter 4 — Configuration Command Reference

Code 39

Enables or disables decoding of Code 39 symbology. Code 39 is discrete, variable length, and self-checking. The character set is uppercase A to Z, 0 to 9, dollar sign ($), period (.), slash (/), percent (%), space ( ), plus (+), and minus (-).

Code 93/93i

Enables or disables decoding of Code 93/93i symbology. Code 93/93i is a variable length, continuous symbology that uses four element widths.

Code 128/EAN 128

Enables or disables decoding of Code 128/EAN 128 symbology. Code 128 is a very high-density alphanumeric symbology that supports the extended ASCII character set. It is a variable length, continuous code that uses multiple element widths.

Code 128 supports the following function codes.

Code 128 Function Codes

<table>
<thead>
<tr>
<th>Function Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNC1</td>
<td>FNC1 is used as a separator when multiple identifiers and their fields are concatenated. For example, FNC1 can be useful in keyboard wedge mode when the GS character cannot be transmitted.</td>
</tr>
<tr>
<td>FNC2</td>
<td>When the FNC2 character occurs in a bar code, the SF51 temporarily stores the data from the bar code and transmits it as a prefix to the next symbol. In this way, FNC2 can be used to concatenate several symbols before the data is transmitted.</td>
</tr>
</tbody>
</table>
**ISBT 128**
Enables and configures decoding of ISBT Code 128 symbology. ISBT Code 128 is the global bar code labeling standard for the blood banking industry. It is used to support the worldwide distribution, tracking, and handling of blood bags and blood components.

**GTIN Processing for EAN 128**
With GTIN processing enabled, a GTIN compliant EAN 128 label will have the first two digits stripped and output 14 digits.

A GTIN (Global Trade Item Number) compliant EAN 128 label:
- is 16 digits long.
- has “01” as the first two digits of the label.

**Configuration Modes and Utilities**
Use Configuration Modes and Utilities to:
- allow the SF51 to always accept configuration commands by scanning bar codes or to timeout 1 minute after the last configuration command is set by scanning a bar code.
- get the product version, sub-system versions, and Bluetooth address of your SF51.
- page the SF51 from your host PC or turn off the SF51.

For more information and bar codes, see “Calling Product Support” on page 28.

**Consecutive Same Read Data Validation**
To increase decode security, you can have the scanner scan a bar code multiple times to ensure you have a valid read before transmitting the data.

You can set Consecutive Same Read Data Validation from 0 to 10. The default value of 0 sets the scanner to automatically adapt the consecutive same read based on the bar code quality and the trust level of the bar code. For example, labels with a check digit require less reads than labels without a check digit.
Chapter 4 — Configuration Command Reference

Data Editing

Data editing allows you to edit data scanned by the SF51 before it is transmitted to your host. You can define up to seven input scenarios to filter out the data you want to edit. For more information, see the EasySet software.

Disable All Symbologies

This command disables all symbologies. Disabling all symbologies does not reset symbology parameters to their default values. To reset all symbology parameters to their default factory settings, use the Administrator Reset Factory Defaults command. For more information, see “Administrator Reset Factory Defaults” on page 40.

EAN.UCC Composite

Enables or disables EAN.UCC Composite symbology. An EAN.UCC Composite symbol consists of a linear component (encoding the item’s primary identification) associated with an adjacent 2D Composite Component (encoding supplementary data, such as a batch number or expiration date). The Composite symbol always includes a linear component so that the primary identification is readable by all scanning technologies, and so that 2D imagers can use the linear component as a finder pattern for the adjacent 2D Composite Component.

Error Beep

Enables or disables the error beep. When you scan a configuration bar code that is damaged or unknown, you hear an error beep, and the configuration of the SF51 is not changed.

Good Read Beep Duration

Sets the length of the SF51 good read beeps. You can set Good Read Beep Duration to a value from 0 (off) to 2550 ms.

Use Good Read Beep Duration in combination with Beep Volume and Beep Frequency to define beeps according to operator preference and work environment.
Good Read Beep Number
Determines the number of beeps used for the good read beep: 1, 2, or none.

Good Read Beep Timing
Determines if the good read beep happens before or after successfully transmitting data.

Good Read LED Duration
Sets the amount of time the green Status light stays on after a good read. You can set Good Read LED Duration to a value from 0 (off) to 5110 ms. When the Status light is on due to a long duration time, the SF51 can still read new bar codes and receive commands.

Interleaved 2 of 5
Enables or disables decoding of Interleaved 2 of 5 symbology. Interleaved 2 of 5 is a high-density, self-checking, continuous numeric symbology. It is mainly used in inventory distribution and the automobile industry.

Matrix 2 of 5
Enables or disables decoding of Matrix 2 of 5 symbology. Matrix 2 of 5 is a discrete bar code derived from Code 11. ChinaPost is available as part of the Matrix 2 of 5 symbology start/stop code. ChinaPost encodes 11 digits with no check digit and has unique start and stop patterns.

Micro PDF417
Enables or disables decoding of Micro PDF417 symbology. Micro PDF417 is a multi-row symbology based on PDF417. It is designed to maximize area efficiency for applications that do not need the maximum data capacity of PDF417. Micro PDF417 contains a limited set of symbol sizes that each includes a fixed level of error correction.
Chapter 4 — Configuration Command Reference

**MSI**

Enables or disables decoding of MSI symbology. MSI code is similar to Plessey code in that it includes a start pattern, data characters, one or two check digits, and a stop pattern.

**PDF417**

PDF417 is only supported on the SF51 with PDF version.

Enables or disables decoding of PDF417 symbology. The PDF417 symbology is a stacked 2D symbology that allows you to scan across rows of code. Each row consists of start/stop characters, row identifiers, and symbol characters, which consist of four bars and four spaces each and contain the actual data. This symbology uses error correction symbol characters appended at the end to recover loss of data.

Macro PDF417, a feature of PDF417, extends the capability of PDF417 by allowing up to 99,999 PDF417 symbols to be used to store data. The symbols are concatenated as they are scanned and can be scanned in any order.

**Plessey**

Enables or disables decoding of Plessey symbology. Plessey code is pulse-width modulated like most other bar codes. It includes a start character, data characters, an eight-bit cyclic check digit, a termination bar, and usually a reverse start character. The code is continuous and not self-checking. You need to configure two parameters for Plessey code: Start Code and Check Digit.

**Postamble**

Sets the postamble that is appended to any data you scan. Common postambles include cursor controls such as a tab or a carriage return line feed. You can set Postamble to up to 20 ASCII characters.

**Preamble**

Sets the preamble that precedes any data you scan. Common preambles include a data location number or an operator number. You can set Preamble to up to 20 ASCII characters.
RSS 14

Enables or disables decoding of RSS 14 (Reduced Space Symbology 14) 1D or stacked 2D codes. RSS 14 is a numeric symbology that can read stacked omni-directional bar code labels. It is a member of the EAN.UCC RSS symbology family.

Note: To read RSS 14 stacked 2D codes, RSS Expanded or RSS Limited must also be enabled.

RSS Expanded

Enables or disables decoding of RSS Expanded (Reduced Space Symbology Expanded). RSS Expanded is an alphanumeric symbology that can read RSS limited and stacked bar code labels. It is a member of the EAN.UCC RSS symbology family.

RSS Limited

Enables or disables decoding of RSS Limited (Reduced Space Symbology Limited). RSS Limited is a numeric symbology that does not read stacked bar code labels. It is a member of the EAN.UCC RSS symbology family.

Setup Beep

Enables or disables the setup beep. When you successfully scan a configuration bar code, you hear the setup beep, and the configuration of the SF51 is changed.

Stacked Code Crackle

Enables or disables the crackle sound when you scan a stacked (2D) bar code.

Standard 2 of 5

Enables or disables decoding of Standard 2 of 5 symbology. Standard 2 of 5 is a low-density numeric symbology. It encodes all information in the bars and uses the fixed-width spaces to separate the bars. Standard 2 of 5 is used in warehouse sorting, photofinishing, and airline tickets.
**Chapter 4 — Configuration Command Reference**

**Symbology Identifier**

Symbology identifiers allow you to indicate what type of data is being sent by prepending an identifier to the data. You can prepend one of the following types of character strings to identify which symbology the data is using.

**Symbology Identifier Options**

<table>
<thead>
<tr>
<th>Character String</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIM ISO/IEC standard</td>
<td>The AIM Standard for symbology identifiers consists of a three-character structure indicating the symbology and the optional features of the symbology. For more information about the AIM Standard for symbology identifiers, refer to the AIM ISO/IEC Standard.</td>
</tr>
<tr>
<td>User-defined ASCII character string</td>
<td>The user-defined symbology identifier (UDSI) is one to four ASCII characters in length. You can configure user-defined symbology identifiers to assign custom identifier strings to the bar code symbologies.</td>
</tr>
<tr>
<td>Code Mark</td>
<td>The code mark identifier is a single character user-defined symbology identifier. Its value can range from 0x00 to 0xFF.</td>
</tr>
</tbody>
</table>

**Telepen**

Enables or disables decoding of Telepen symbology. Telepen is the only symbology to directly represent the full ASCII character set without shift characters. It is extremely secure as it has negligible risk of misreads and has a double density numeric only mode.
Timeout Between Different Consecutive Codes

Use this command to invalidate a second bar code read that occurs before the timeout expires. Use this command when scanning bar codes that contain different data as opposed to the Timeout Between Identical Consecutive Codes command that you use when your bar codes contain identical data.

You can set Timeout Between Different Consecutive Codes to a value from 0 to 2550 ms.

Timeout Between Identical Consecutive Codes

Use this command to invalidate a second bar code read that occurs before the timeout expires. Use this command when scanning bar codes with identical data as opposed to the Timeout Between Different Consecutive Codes command that you use when your bar codes contain different data.

You can set Timeout Between Identical Consecutive Codes to a value from 0 to 2550 ms.

TLC 39

TLC 39 is a “composite” symbology designed for the Telecommunications Industry. TLC 39 combines a Code 39 symbol, encoding a part number (for items such as plug-in boards at central switching stations) with a “linked” MicroPDF417 symbol encoding a serial number and other optional information.

The first 6 characters must be numeric and include the ECI number. The 7th character is a delimiter between the linear data portion and the composite data portion, typically a comma, but other delimiters are allowed. The next piece of data is a mandatory unique Serial Number.

There can be other data fields after the Serial Number, usually either AppIDs or DataIDs, which are governed by whether or not there are alpha characters in the serial number. Country Of Origin is another typical data field that is included in this symbology.
Chapter 4 — Configuration Command Reference

**Trigger Mode**

Trigger mode allows you to set different types of triggering for the scanner.

**Trigger Mode Options**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous/Edge</td>
<td>When you press the <strong>Scan</strong> button, the red scanner beam turns and stays on. When you press the <strong>Scan</strong> button a second time, the scanner turns off. Simply releasing the button does not turn off the scanner.</td>
</tr>
<tr>
<td>Level</td>
<td>When you press the <strong>Scan</strong> button, the red scanner beam turns on and stays on until you release the <strong>Scan</strong> button or until the SF51 successfully decodes a bar code.</td>
</tr>
<tr>
<td></td>
<td>When you scan a data bar code, data transmission may be slow if there is interference with Bluetooth communications, or if the SF51 is too far from the host device. While the SF51 is waiting, the scanner beam blinks. During this time, you can scan configuration bar codes but not data bar codes. When the SF51 receives acknowledgement from the host, the scanner turns off, and the SF51 beeps.</td>
</tr>
<tr>
<td>Pulse</td>
<td>When you press the <strong>Scan</strong> button, the red scanner beam turns on. The scanner remains on until the Trigger Timeout period is reached.</td>
</tr>
<tr>
<td>Flashing</td>
<td>When you press the <strong>Scan</strong> button, the red scanner beam turns on and the SF51 checks for a bar code to read. When the Trigger Timeout period is reached, the scanner starts flashing. When the SF51 finds and reads a bar code, it resets the Trigger Timeout period. If you press the <strong>Scan</strong> button a second time, the scanner turns off.</td>
</tr>
</tbody>
</table>
Chapter 4 — Configuration Command Reference

Trigger Mode Options (continued)

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autostand</td>
<td>Autostand mode allows you to switch between level mode and flashing mode. The first time you press the Scan button, the scanner beam turns on and the scanner is in flashing mode. You switch to level mode by pressing the Scan button again. If the scanner is idle and the Trigger Timeout period is reached, the scanner returns to flashing mode.</td>
</tr>
<tr>
<td>Aim</td>
<td>Aim triggering allows you to turn on the scanner and aim the red scanner beam without causing a decode. Releasing the Scan button enables the decode.</td>
</tr>
</tbody>
</table>

Note: EasySet contains a folder, predefined modes, in Operating settings > trigger activation. The commands in this folder are currently not supported on the SF51.

Trigger Timeout

Set the Trigger Timeout for the Trigger Mode command. You can set Trigger Timeout from 1 to 4095 seconds.

Turn Off After Good Read

Sets how the SF51 operates in level and pulse trigger modes.

<table>
<thead>
<tr>
<th>Trigger Mode</th>
<th>Turn Off After Good Read</th>
<th>SF51 Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>Enabled</td>
<td>The SF51 turns off after it successfully reads a bar code.</td>
</tr>
<tr>
<td>Level</td>
<td>Disabled</td>
<td>The SF51 stays on until you release the Scan button.</td>
</tr>
<tr>
<td>Pulse</td>
<td>Enabled</td>
<td>The SF51 turns off after it successfully reads a bar code.</td>
</tr>
<tr>
<td>Pulse</td>
<td>Disabled</td>
<td>The SF51 stays on until the Trigger Timeout period is reached.</td>
</tr>
</tbody>
</table>
Chapter 4 — Configuration Command Reference

UPC/EAN
Enables or disables decoding of Universal Product Code (UPC)/European Article Numbering (EAN) symbology. UPC/EAN are fixed-length, numeric, continuous symbologies that use four element widths. A scanner that is configured to decode EAN bar codes can decode UPC, but the reverse is not true. UPC code is a subset of EAN code.

ISBN
ISBN (International Standard Book Number) is a 10-digit symbology that uniquely identifies books for tracking and ordering.

With ISBN enabled, the first three characters (978) are ignored, and the checksum is calculated on the remaining characters.

GTIN Processing
With GTIN (Global Trade Item Number) processing enabled, two zeros are padded to the beginning of UPC-A, and one zero is padded to the beginning of EAN-13 to expand the numbers to 14 digits. To use GTIN processing you also need to enable the corresponding UPC/EAN symbology.

User Reset Factory Defaults
Causes the SF51 to perform a restart and restores all configuration commands to their default settings, only if no settings are locked. To reset all settings on the SF51, including locked settings, use the Administrator Reset Factory Defaults command. For more information, see “Administrator Reset Factory Defaults” on page 40.

When you restore all configuration commands to their default settings, you need to reestablish Bluetooth communications.

Vibrate Alert
Enables or disables the vibrate alert. When Vibrate Alert is enabled, the scanner vibrates when you scan a valid bar code.

Vibrate Alert Duration
Sets the amount of time that the vibrate alert remains on. You can set Vibrate Alert Duration to a value from 0 to 2550 ms.
Appendix
Appendix A

Specifications

Use this section to find technical information about the SF51.

Physical Dimensions
Length: 15.7 cm (6.1 in)
Height: 3.4 cm (1.3 in)
Width: 4.6 cm (1.8 in) at the scanner, tapered to 3.2 cm (1.26 in) at the handle
Weight: 263 g (9.3 oz)

Power and Electrical Specifications
Operating: Rechargeable lithium-ion battery
Electrical rating: 5V; 1.5A

Temperature and Environmental Specifications
Operating: -20°C to 50°C (-4°F to 122°F)
Storage: -20°C to 60°C (-4°F to 140°F)
Charging: 0°C to 45°C (32°F to 113°F)
Relative humidity: 0 to 95% non-condensing
Environmental rating: IP52

Bar Code Symbologies
- Codabar
- Codablock A
- Codablock F
- Code 11
- Code 39
- Code 93/93i
- Code 128 / EAN 128
- EAN.UCC Composite
- Interleaved 2 of 5
- Matrix 2 of 5
- Micro PDF417
- MSI
- PDF417
- Plessey
- RSS 14
- RSS 14 Stacked
- RSS Limited
- RSS Expanded
- Standard 2 of 5
- Telepen
- TLC 39
- UPC/EAN
Note: PDF417 and Micro PDF417 are only available on the SF51 with PDF version.

Bluetooth Radio
Radio Type: Bluetooth Class 1 version 1.2
Frequency: 2.4 GHz
Radio Data Rate: 721 Kbits per second

Communication Range
Host radio Class 1: 30.5 m (100 ft)
Host radio Class 2: 10 m (32.8 ft)
Features: Adaptive Frequency Hopping (ADF)

EV10 Scanner
Scan rate: 200 scans per second
Scan range: up to 50 cm (19.7 in)
Scan angle: 40 degrees
Minimum X dimension: 4 mils (0.1 mm)

Accessories for the SF51
You can use these accessories (sold and ordered separately) with the SF51. To order accessories, contact your local Intermec sales representative.

Accessories for the SF51

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Bay Charger</td>
<td>The 1-bay charger (P/N 074645) charges the battery in the SF51 and is designed to be mounted on a horizontal or vertical surface.</td>
</tr>
<tr>
<td>1-Bay Charger Power Supply</td>
<td>The power supply for the 1-bay charger (P/N 074749) provides AC power to the 1-bay charger. It comes with power supply adapters for Australia, Continental Europe, United Kingdom, North America, Central America, Mexico, and Japan. It also comes with a flat plate for use with an AC power cord. The AC power cord is not included.</td>
</tr>
</tbody>
</table>
### Accessories for the SF51 (continued)

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-Bay Charger</td>
<td>The 4-bay charger (P/N 074646) has the same functionality of the 1-bay charger, except it allows you to charge up to four SF51 scanners at the same time.</td>
</tr>
<tr>
<td>4-Bay Charger Power Supply</td>
<td>The power supply for the 4-bay charger (P/N 074935) provides AC power to the 4-bay charger.</td>
</tr>
<tr>
<td>USB Bluetooth Adapter</td>
<td>The USB Bluetooth Adapter (P/N 074892) provides wireless communications to your host computer and data collection application.</td>
</tr>
<tr>
<td>Forearm Holster</td>
<td>The forearm holster (P/N 074649) provides you with an easy way to carry the SF51 when you are not using it. The holster supports either right-handed or left-handed use.</td>
</tr>
<tr>
<td>Chest Strap Holster</td>
<td>Use the chest strap holster (P/N 074648) to carry the SF51 when you are not using it.</td>
</tr>
<tr>
<td>Industrial belt clip holder</td>
<td>Use the belt clip (P/N 074811) to carry the SF51 when you are not using it.</td>
</tr>
</tbody>
</table>
Index

Numbers
1.2, firmware, what’s new, 3
1-bay charger
   accessory, described, 57
   power supply, accessory, described, 57
4-bay charger
   accessory, described, 58
   power supply, accessory, described, 58

A
accessories, described, 57
Administrator Reset Factory Defaults
   bar code, 29
   command, 40
aim, Trigger Mode, described, 53
audio feedback, See beeps
autostand, Trigger Mode, described, 53

B
bar code symbologies
   Codabar, 43
   Codablock A, 43
   Codablock F, 43
   Code 11, 43
   Code 128 / EAN 128, 44
   Code 39, 44
   Code 93/93i, 44
   EAN.UCC Composite, 46
   Interleaved 2 of 5, 47
   ISBT 128, 45
   Matrix 2 of 5, 47
   Micro PDF417, 47
   MSI, 48
   PDF417, 48
   Plessey, 48
   RSS 14, 49
   RSS Expanded, 49
   RSS Limited, 49
   Standard 2 of 5, 49
   Telepen, 50
   TLC 39, 51
   UPC/EAN, 54

bar codes
   scanning
      how to, 9
      troubleshooting, 31
   setup sheet, described, 14
Index

bar codes (continued)
supported symbologies, 56
symbologies, default, 9
battery
charger
1-bay charger, described, 57
4-bay charger, described, 58
charging, 5
checking status, 5
using, 4
Beep Duration command, 40
Beep Frequency command, 40
Beep Volume command, 41
beeper, turning off, 8
beeps, understanding, 7
belt clip, accessory, described, 58
blue light, See Intermec Ready-to-Work indicator
Bluetooth
adapter
accessory, described, 58
installing, 20
communications
configuring, 17
host PC, connecting to, 20
troubleshooting, 29, 30
Connect/Disconnect command, 41
Device Name command, 41
Device Page command
described, 41
how to locate your SF51, 32
Discoverable command, 42
host devices supported, 18
PIN
command, 42
forgot, troubleshooting, 31
security, configuring, 17
Profile command, 42
radio
communication
configuring, 17
range, 57
specifications, 57
Security command, 43
SF51 Bluetooth address
how to get, 28
illustration, 19
Index

Bluetooth Device Disconnect, bar code, 20
button, scan, illustration, 2

C
calling Product Support, 28
charger
  1-bay charger, described, 57
  4-bay charger, described, 58
charging, battery, 5
chest strap holster, accessory, described, 58
ChinaPost, Matrix 2 of 5 setting, described, 47
cleaning, scanner window, 33
Codabar command, 43
Codablock A command, 43
Codablock F command, 43
Code 11 command, 43
Code 128 / EAN 128 command
described, 44
  function codes, described, 44
  GTIN Processing for EAN 128, 45
  ISBT 128, 45
Code 39 command, 44
Code 93/93i command, 44
collecting data, how to, 10
commands, See configuration commands
communication range, Bluetooth radio, 57
computers, Bluetooth supported, 18
configuration commands
  Administrator Reset Factory Defaults, 40
  Beep Duration, 40
  Beep Frequency, 40
  Beep Volume, 41
  Bluetooth Connect/Disconnect, 41
  Bluetooth Device Name, 41
  Bluetooth Device Page, 41
  Bluetooth Discoverable, 42
  Bluetooth PIN, 42
  Bluetooth Profile, 42
  Bluetooth Security, 43
  Codabar, 43
  Codablock A, 43
  Codablock F, 43
  Code 11, 43
Code 128 / EAN 128, 44
  GTIN Processing for EAN 128, 45
  ISBT 128, 45
Code 39, 44
Index

configuration commands (continued)
   Code 93/93i, 44
   Configuration Modes and Utilities, 45
   Consecutive Same Read Data Validation, 45
   Data Editing, 46
   default values, 37 to 40
   Disable All Symbologies, 46
   EAN.UCC Composite, 46
   Error Beep, 46
   Good Read Beep Duration, 46
   Good Read Beep Number, 47
   Good Read Beep Timing, 47
   Good Read LED Duration, 47
   Interleaved 2 of 5, 47
   ISBT 128, 45
   Matrix 2 of 5, 47
   Micro PDF417, 47
   MSI, 48
   PDF417, 48
   Plessey, 48
   Postamble, 48
   Preamble, 48
   RSS 14, 49
   RSS Expanded, 49
   RSS Limited, 49
   Setup Beep, 49
   Stacked Code Crackle, 49
   Standard 2 of 5, 49
   Symbology Identifier, 50
   Telepen, 50
   Timeout Between Different Consecutive Codes, 51
   Timeout Between Identical Consecutive Codes, 51
   TLC 39, 51
   Trigger Mode, 52
   Trigger Timeout, 53
   Turn Off After Good Read, 53
   UPC/EAN, 54
      GTIN processing, 54
      ISBN, described, 54
   User Reset Factory Defaults, 54
      using to configure the SF51, 36
   Vibrate Alert, 54
   Vibrate Alert Duration, 54
   Configuration Modes and Utilities
      bar codes, 28
      command, 45
configuring
configuring Bluetooth communications, 17
from Intermec computer, 15
parameters, 14
security, 17
using EasySet, 14
calculating to a host device
as a keyboard wedge, 21
host PC, 20
Intermec computer, 19
overview, 18
Consecutive Same Read Data Validation command, 45
countinuous/edge, Trigger Mode, described, 52
D
Data Editing command, 46
data transmission settings, configuration commands, list of, 37
data, collecting, 10
default configuration
restoring, 16
values, 37 to 40
dimensions, physical, 56
Disable All Symbologies command, 46
disconnecting, how to, 20
discoverable state
described, 42
security, configuring, 18
E
EAN 128, GTIN processing, 45
EAN.UCC Composite command, 46
EasySet
using to configure SF51
offline, 15
online, 14
where to download, 9
electrical specifications, 56
environmental specifications, 56
Error Beep command, 46
F
factory default settings, restoring, 16
firmware
upgrading, 22
version 1.2, what’s new, 3
version, how to get, 28
FNC1, Code 128 / EAN 128 function code, described, 44
FNC2, Code 128 / EAN 128 function code, described, 44
Index

forearm holster, accessory, described, 58
forgot Bluetooth PIN, troubleshooting, 31

G
Get Product Version bar code, 28
Get SF51 Bluetooth Device Address bar code, 28, 29
Good Read
  Beep
    Duration command, 46
    Number command, 47
    Timing command, 47
  LED Duration command, 47
green light, See status light
GTIN processing
  EAN 128, 45
  UPC/EAN, 54

H
help, calling Intermec, x
holster, accessories, described, 58
humidity, specifications, 56

I
Interleaved 2 of 5 command, 47
Intermec
  computer
    connecting to, 19
    supported, 18
    using to configure SF51, 15
  contact information, ii
  Ready-to-Work indicator
    described, 7
    illustration, 6
telephone support, x
ISBT 128 command, 45

K
keyboard wedge
  collecting data, 11
  connecting, 21
troubleshooting, 31
Keyport Lite, described, 21

L
.ldr, firmware upgrade file, 22
labels, bar code, scanning, 9
level, Trigger Mode, described, 52
Index

lights
   blue, See Intermec Ready-to-Work indicator
   Intermec Ready-to-Work indicator, described, 7
   status, described, 6
   understanding, 5
limited discoverable
   bar code, 18
   described, 42
M
   Macro PDF417, described, 48
   magnetic connector, illustration, 2
   Matrix 2 of 5 command
      ChinaPost, 47
      described, 47
   Micro PDF417 command, 47
   MSI command, 48
N, O
   new, in this revision, 3
   off, turning off the SF51, 4
   on, turning on the SF51, 4
   operating settings, list of, 39
   operating the SF51
      humidity range, 56
      temperature range, 56
P
   paging the SF51, how to, 32
   parameters, configuring SF51, 14
   PDF417 command, 48
   physical
      dimensions, 56
      specifications, 56
   Plessey command, 48
   Postamble command, 48
   power down bar code, 4
   power specifications, 56
   power supply
      1-bay charger, accessory, described, 57
      4-bay charger, accessory, described, 58
   Preamble command, 48
   problems, finding and solving, 29
   Product Support, calling, 28
   product version, how to get, 28
   pulse, Trigger Mode, described, 52
Index

R
radio
  communications, configuring, 17
  specifications, 57
Ready-to-Work indicator
  described, 7
  illustration, 6
red light, See status light
resetting, SF51, 32
restoring default settings, 16
RSS 14 command, 49
RSS Expanded command, 49
RSS Limited command, 49

S
Scan button
  illustration, 2
  troubleshooting, 30
scanner, See SF51
scanner window, cleaning, 33
scanning
  bar codes
    described, 9
    how to hold the SF51, 10
    troubleshooting, 31
security
  Bluetooth PIN, 17
  configuring, 17
  discoverable state, 18
Serial port profile, Bluetooth
  configuring, 42
  described, 17
  disconnecting, 20
  resetting the SF51, 32
settings, restoring default, 16
Setup Beep command, 49
SF51
  Bluetooth address
    how to get, 28
    illustration, 19
  cleaning, 33
  configuring, 14
  connecting to a host device
    as a keyboard wedge, 21
    host PC, 20
    Intermec computer, 19
    overview, 18
Index

SF51 (continued)
description, 2
firmware
  upgrading, 22
  version, how to get, 28
  what's new in this revision, 3
how to turn on, 4
locating using Bluetooth Device Page command, 32
paging using Bluetooth Device Page command, 32
product version, how to get, 28
resetting, 32
scan engine, specifications, 57
sub-system version, how to get, 28
troubleshooting, 28
turning off, 4
turning on, 4
upgrading, 22
using to scan bar codes, 9
what's new for firmware version 1.2, 3
with PDF version
  bar code symbologies supported, 57
  default bar code symbologies, 9
sounds, See beeps
specifications
  electrical, 56
  humidity, 56
  power, 56
  radio, Bluetooth, 57
  scan engine, 57
  temperature, 56
SPP, See Serial port profile
Stacked Code Crackle command, 49
Standard 2 of 5 command, 49
status
  beeps, 7
  checking battery, 5
  light
    described, 6
    illustration, 6
sub-system version, how to get, 28
support, calling Intermec, x
symbologies, bar code
  default, 9
  list of, 38
  supported, 56
Symbology Identifier command, 50
Index

T
Telepen command, 50
temperature, specifications, 56
Timeout Between Different Consecutive Codes command, 51
Timeout Between Identical Consecutive Codes command, 51
TLC 39 command, 51
Trigger Mode command, 52
Trigger Timeout command, 53
troubleshooting
  Bluetooth PIN, forgot, 31
  cannot establish a Bluetooth connection, 29, 30
  guide to finding problems, 29
  keyboard wedge mode, 31
  lost Bluetooth connection, 29
  resetting the SF51, 32
  Scan button, 30
  scanning, 31
Turn Off After Good Read command, 53
turning off the SF51, 4
turning on the SF51, 4

U
understanding
  beeps, 7
  lights, 5
UPC/EAN command, 54
  GTIN processing, 54
  ISBN, 54
upgrading, SF51, 22
USB Bluetooth adapter, See Bluetooth adapter
User Reset Factory Defaults command, 54

V
Vibrate Alert
  command, described, 54
  described, 8
  turning off, 8
  turning on, 8
Vibrate Alert Duration command, 54
volume, adjusting, 41

W
wedge, keyboard, See keyboard wedge
what’s new in this revision, 3
wireless communications, configuring, 17
Index